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Lesson objectives

m Todiscusssome of the decisions you need to make before using QuickBooks, such as
your QuickBooks start date and the number of QuickBooks companies you should
Create

m To create a new QuickBooks company using the EasyStep Interview

m  Toset QuickBooks preferences in the Interview

m  Torecord the opening balance for a checking account

m To create customers, jobs, vendors, accounts, and items for a QuickBooks company

m To practice using the QuickBooks Help tools

Supporting materials

m PowerPoint file: Lesson 2

Instructor preparation

m  Review this lesson, including the examples, to make sure you're familiar with the
material.

m  Ensure that all students have a copy of gblesson.gbb on their computer’s hard disk.

Creating a QuickBooks company

A QuickBooks company contains all the financial records for a single business. Before
you can use QuickBooks, you need to tell QuickBooks about your business so that it can
set up your company file. Setting up your company file properly is the most important
thing you can do to help yourself manage your business efficiently and with
confidence.

If you’ve been using Quicken or an earlier version of QuickBooks to keep your company’s
financial records, you don’t need to create a new company; QuickBooks can convert the
data for you. See the QuickBooks Startup and Quick Reference Guide for detailed
instructions, or search the onscreen Help index for “Quicken.”
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Explain to students that if they’ve been using Quicken or an older version of QuickBooks
to keep their company’s financial records, they don’t need to create a new company;
QuickBooks can convert their data for them. However, in this lesson, you’ll be showing
them how to create a new QuickBooks company.
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Setting up QuickBooks

How many companies should you set up?

If you operate a business enterprise, the IRS expects you to clearly show all sources of
income and to document any business expenses you claim as deductions. For tax
purposes, therefore, it’s usually best to set up a separate QuickBooks company for each
business enterprise you report on your tax forms.

About the EasyStep Interview

The EasyStep Interview walks you through the process of setting up your business on
QuickBooks. The setup process is easy; the EasyStep Interview should take you only
about 30 minutes to complete. When you set up your company file, QuickBooks will ask
you for a number of details about your company.

Most small business owners do better with QuickBooks setup if they break the job into
manageable chunks. Here’s a suggested schedule for completion:

Choose the QuickBooks start date.
Gather the necessary business information and documents.
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Set up the company file using the EasyStep Interview.

Fine-tune the chart of accounts.
Enter any historical transactions.
Complete customer and vendor information.

Complete the Item list.
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Enter any optional adjustments.

Navigating through the Interview
m Click Next to display the next window in the Interview.

m Click Prev to display the previous window in the Interview.

m Click Leave to leave the Interview and return to QuickBooks. The next time you
open the company file, QuickBooks remembers the information you have already
entered and returns you to the EasyStep Interview where you left off.

Set aside a block of uninterrupted time to work on setting up your QuickBooks file. Don’t
try to complete the setup while you're in the middle of a busy workday. If you schedule
your time before or after work hours, or on the weekend, setup should take a few hours.

Your goal while setting up is to provide as much information as necessary to get going,
but not to provide all the details at once. For example, you could enter data for only your
biggest customers and vendors. Later, you can enter customer and vendor data as you
begin working in QuickBooks. (Or, if you have an especially large customer base, you may
wish to hire a data entry clerk to complete this task for you.)
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Starting the EasyStep Interview

To begin adding a new company:

1 Start QuickBooks.

2 Select “Create a new company,” click the “Start your new company file now”
button, or choose New Company from the File menu.

QuickBooks displays the EasyStep Interview window.

EasyStep Interview

QuickBooks
EasyStep Interview

—_—

—

Interview Progress

Need help setting up?

Find A Local
+ QuickBooks Expert @
(fees may apply)

¥ Getanswers

@ Welcome to the QuickBooks EasyStep Interview

we'll walk you through setting up the basics by asking you questions and giving you guidance along
the way. In about 30 minutes you'll be ready to start using QuickBooks—customized just for you!

Other Options
Have you used Quicken, Peachtree, or Are you an accountant or
Office Accounting for your business? QuickBooks expert?
Click Convert Data if you would like to Click Skip Interview to set up your
transfer your finandal information to company information on your own,
QuickBooks.
What happens to my converted data?

Convert Data - Skip Interview

Need on-site help?
Local Certified QuickBooks ProAdvisors can set up & customize QuickBooks for your business. (fees
may apply) ¥ Learn More

Entering company info

When you use the EasyStep Interview to create a new QuickBooks company,
QuickBooks asks you questions about the type of business you own. It uses your answers
to get you started quickly, by setting up the appropriate accounts and lists.

In this lesson, you’ll create a new QuickBooks company for a business named Lockhart
Design. Margaret Lockhart is the sole proprietor of this interior design firm. Most of her
income comes from consulting services, but she also sells products such as fabrics and
room accessories to clients.

To create a new QuickBooks company file:

1 Atthe first Welcome window for the EasyStep Interview, click Start Interview.

The “Enter Your Company Information” window appears.

2 Inthe Company Name field, type Lockhart Design and press Tab.

When you press Tab, QuickBooks automatically enters the same name you typed
into the Legal Name field. QuickBooks uses the company name on all reports.

3 Press Tab and enter 94-1234567 as the Tax ID number.

35



Setting up QuickBooks

4 Type the following information in the street address, city, state, and zip fields.

1239 Bayshore Road
Middlefield, CA 94432

QuickBooks prints this company address on checks, invoices, and other forms.
5 Now enter the following information in the Phone number and Fax number fields:
Phone: 650-555-1234
Fax: 650-555-5678
6 Next enter the email and Web addresses for Lockhart Design.
Email: margaret@samplename.com
Web Site: www.lockhart_design.com

Your screen should resemble the following.

E
i Getanswers
QuickBooks Enter your company information
EasyStep Interview QuickBooks uses this information on your tax forms and forms you use to communicate with your
—_— customers and vendors.

Company name |Ludchart Design
Legal name

Interview Progress

Iankhart Design

a0, [ae-1234887

Your Federal Employer Ide curity Number,

Usex

Street address IIZEQ Bayshore Road

Gty [Middeeld State [ca =] 7P [oaanz
Country Im
Phone

[e50-555-1234 Fax  [gs0ss55678

Use the format you would like displayed on your forms, e.g

S B |margaret@samp\ename.cnm
Web site

Iwww‘\odchartfdeslgn.com
Need help setting up?
Find A Local
 QuickBooks Expert %

{fees may apply) Leave... < Back Hext >

What if I have more than one business?

7 Click Next.

Choosing your company industry

When you create a new QuickBooks company, you can select a company type that most
closely matches your type of business, and QuickBooks sets up accounts and lists that
are appropriate for your type of company.

Your industry selection is used by the interview to ask questions and recommend
features that work best for your business.

QuickBooks will recommend features that can best meet your business needs, such as:
m  Enabling sales tax for retail businesses

m  Using estimates in QuickBooks for some service-based businesses

m  Managing inventory in QuickBooks for wholesalers and manufacturers

m Creating income and expense categories
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Even if you own a type of company that isn’t specifically listed, you should select the
one that’s closest. Margaret Lockhart does consulting, as well as retail sales, so we’ll
select a Retail company type.

To choose the company industry:

1 On the “Select your industry” window, scroll down the list until you find Retail
Shop or Online Commerce and select it.

X
if Getanswers
QuickBooks Select your industry
EasyStep Interview
—_—

™ —— You will be able to review our recommendations and change them in this interview. And, you can
always change each of these settings later. Explain

Tell us your industry and we'll customize QuickBooks to work best for you.

Interview Progress
Don't see your industry? Choose an industry that is similar to yours. Examples

Select an industry from the list

Industry |
Lodging (Hotel, Motel) «
Manufacturer Representative or Agent
Manufacturing
Medical, Dental, or Health Service
Non-Profit
Professional Consulting

Property Management or Home Assodation
Real Estate Brokerage or Developer
Rental
Repair and Maintenance
Restaurant, Caterer, or Bar
Retail Shop or Online Commerce
|

Sales: Independent Agent
Transportation, Trucking, or Delivery
Wholesale Distribution and Sales -

Need help setting up? How does QuickBooks use my industry selection?
Find A Local
< QuickBooks Expert %
{fees may apply) Leave... < Back Next >

Although Lockhart Design receives most of its income from consulting, not from
retail sales, the Retail company type will give us most of the accounts we need. She’ll
need to modify the chart of accounts later to include an income account for
Consulting Income.

2 Click Next.

e “How is your company organized” window appears.
The “H d” d

Selecting how your company is organized

Selecting how your company is organized tells QuickBooks which tax forms to use for
your business. You also indicate the start of your fiscal year.

Lockhart Design is a sole proprietorship: an unincorporated business with one owner.
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Setting up QuickBooks

To select your company organization:

1 Click Sole Proprietorship to select it.

QuickBooks

Need help setting up?

Find A Local
- QuickBooks Expert
(fees may apply)

EasyStep Interview

—
| I

Interview Progress

o

EasyStep Interview

i Getanswers

How is your company organized?

‘Your selection will help QuickBooks create the correct accounts for your business entity
and assign tax form lines to those accounts.

(FORM 1040)

" partnership or LLP

(FORM 1065)

e

ISingIe-member LLiC {Form 10400 j

" Corporation (also known as Regular or C Corporation)
(FORM 1120)

" § Corporation
(FORM 1120-5)

" Non-Profit
(FORM 990)

" Other/None

Which business entity should I choose?

Leave... | < Back Next >

This tells QuickBooks to use the 1040 tax form. When you create a new account, you
can associate a tax line on which you would report the income or expenses tracked
by the account.

An account's tax line associates each income and expense account with the
appropriate tax form and line on your company income tax return. You'll see tax
lines for the tax form you choose and for schedules and other forms typically filed
with that tax form. This makes preparing income taxes easier and quicker, because
it enables you to create tax reports to assist your accountant or to export and import
your tax data into TurboTax, TurboTax Business, ProSeries, or Lacerte tax programs.
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2 Click Next.

QuickBooks needs to know the starting month of your fiscal year.

x
¥ Getanswers
QuickBooks Select the first month of your fiscal year
EasyStep Interview
—_—
[ — Your fiscal year is typically the same as your income tax year. Explain

Interview Progress

My fiscal year starts i[RI~ |

Meed help setting up?

Find A Local
- QuickBooks Expert @

(fees may apply) Leave... | < Back Mext =

3 Since Lockhart Design’s fiscal year started in January, leave January selected and
click Next.

The “Set up your administrator password” window appears. For this exercise, you
don’t need to set up a password.

EasyStep Interview x|

¥ Getanswers

QuickBooks Set up your administrator password

EasyStep Interview
We recommend you set up 3 password to protect your company file. You will be prompted

f for this password whenever you open this file. It is optional to set up a password,
| —
Interview Progress Administrator password l—
Retype password

What is an "administrator”? Entering a password here sets up the administrator user, who
has full access to all activities and information in QuickBooks. When you are ready, you can setup
other users with more limited privileges.

You can also set up or change your administrator password later.

Need help setting up?

Find A Local
< QuickBooks Expert

(fees may apply) Leave... | < Back Next >

4 Click Next.

The “Create your company file” window appears.
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Setting up QuickBooks

5 Click Next to save the company file.

6 Inthe “Filename for New Company” window, make sure that QuickBooks is set to
save the file in the QBtrain folder you set up in the introduction to this guide.

7 Click Save to accept the default filename of “Lockhart Design.”

QuickBooks creates the company file.

Customizing QuickBooks for your business

The customization section of the EasyStep Interview is where you indicate:
m  Whatyou sell
m  How and when your customers pay you

m  How you pay your bills

Based on your answers, QuickBooks sets preferences for the company file. The
preferences enable certain features of the QuickBooks program.

x
 Getanswers
QuickBooks Customizing QuickBooks for your business
EasyStep Interview Next, we'l customize QuickBooks by turning on features that best meet your business
— needs. To do this, we'll ask you questions about:
|

T Your industry and what you sell
How and when your customers pay you

How you pay your bills

The features that appear in your
EE - 1w = custom Home page will be based
on your answers.
3 &
[ o -
i 5 % 8
= e
3 & PO =
:

Not sure what you'll need for your business? Answer the interview questions based on your

Need help setting up? current needs. You can easily enable additional features later.
Find A Local
< QuickBooks Expert @ _
(fees may apply) Leave... | < Back
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Indicating what you sell

You need to indicate what your business sells. In general, businesses either sell products
or services, or both. Margaret Lockhart provides consulting services as well as selling
products, such as fabrics.

To indicate what you sell:

1 Click Next to move to the “What do you sell?” window.

2 Click “Both services and products” to select it.

EasyStep Interview x|
i Getanswers

QuickBooks What do you sell?

EasyStep Interview € Services only

Such as consulting, rentals, gym memberships, hair styling services, event services,
] construction and labor.

Interview Progress

' Products only
Such as lamps, fertilizer, books, hardware, tickets, insurance polides, Manufacturers and
distributors should also select this option.

s
that sells bikes, a carpet installation company that sells

carpet.

Need help setting up?

Find A Local
< QuickBooks Expert %

{fees may apply) Leave... < Back Next >

3 Click Next.

Entering sales information

Forretail companies, you need to indicate how you want to enter sales. QuickBooks uses
this information to set recommendations for a retail-type business. Margaret Lockhart
does not do retail sales on a daily basis, so she will record her sales as they occur.
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Setting up QuickBooks

To indicate how you enter sales:

1

In the “How will you enter your sales in QuickBooks?” window, click “Record each
sale individually.”

Your screen should look like this:

E
i/ Getanswers
QuickBooks How will you enter your sales in QuickBooks?

EasyStep Interview & Record each sale individually
‘You can also print sales receipts to give customers,

| —

Interview Prog " Record only a summary of your daily or weekly sales

If you use a cash register to ring up individual sales, you can enter the sales totals (for the
day, week, etc.) into QuickBooks.

" Use QuickBooks Point of Sale
‘You can send the details of each individual sale into QuickBooks—with just one dick.

Need help setting up?

Find A Local
< QuickBooks Expert @

{fees may apply) Leave... < Back Next >

Click Next.

In the “Doyousell products online?” window, make sure the “I don’t sell online and
[ am not interested in doing so” option is selected.

Margaret Lockhart has no plans to sell online.

Entering sales tax information

This part of the EasyStep Interview asks whether you charge sales tax. You should turn
the sales tax setting off only if you never charge sales tax. Margaret Lockhart typically
charges sales tax, so we’ll turn on sales tax in her company file.

To set up QuickBooks to track sales tax:

1

2

Click Next in the “Do you sell products online?” window to move to the “Do you
charge sales tax?” window.
Click Yes for the question, “Do you charge sales tax?”

QuickBooks sets up three sales tax items you can use on sales forms to track your
sales tax: Local Tax, Out of State, and State Tax. In your own business company file,
you would edit these tax items to enter the current tax rates.

Click Next.

QuickBooks automatically creates a current liability account, called Sales Tax
Payable, that keeps track of the sales tax you collect in your business.




Creating estimates

If you provide any type of estimate or bid—even a verbal quote—there are many reasons
to use estimates in QuickBooks.

You can use the QuickBooks estimate form to prepare professional-looking itemized
estimates, bids, quotes, or proposals for your customers. You can customize a
QuickBooks estimate to look and say exactly what you want it to.

When it's time to bill your customer, you can easily create an invoice from the
estimate with just one click. QuickBooks then creates an invoice using information
from your estimate. You can also associate price levels with your customers and use
those price levels on estimates.

When you need to know how accurate your estimates are, you can create reports
that compare your estimated costs and revenue against your actual costs and
revenue.

Creating estimates in QuickBooks will allow you to easily compare your actual costs
against what you estimated. This will let you see how accurate your estimates are.

You can track which estimates are still active and easily update each estimate as you
continue to negotiate with your customers.

For this exercise, Margaret Lockhart creates proposals for her customers for their interior
design projects, so she needs to enable estimates for her company.

To create estimates for your business:

1

On the “Do you want to create estimates in QuickBooks?” window, click Yes.

X
if Getanswers
QuickBooks Do you want to create estimates in QuickBooks?
EasyStep Interview Some businesses refer to estimates as quotes, bids, or proposals.
Interview Progress ® Ves
o
Why should T use QuickBooks to areate my
Need help setting up?
Find A Local
< QuickBooks Expert %
(fees may apply) Leave... < Back Next >

2 Click Next.
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Setting up QuickBooks

Using sales orders

If your customers sometimes place orders for items that you don't have in stock or are
not yet ready to invoice for, use a sales order in QuickBooks to track the sale.

Note: On the next window, if you are using a QuickBooks Premier Edition
product, QuickBooks asks if you want to track sales orders.

To set up sales orders:
1 On the “Tracking customer orders in QuickBooks” screen click Yes.

EasyStep Interview x|

¥ Getanswers

QuickBooks Tracking customer orders in QuickBooks

EaEySteD Interview Use a sales order to track customer orders that you plan to fill at a later date, such as
backord

s or special orders.

| —

Interview Progress

Sales orders can be used to track any of your orders or your i V.

Some examples:

A bike shop receives an order for a custom-built bike. A sales order is used to track the
order and is then conwverted to an invoice when the customer picks up the finished bike,

A wholesaler receives an order for 1,000 couches. The sales order adjusts inventory levels
to show these couches are spoken for,

Do you want to track sales orders before you invoice your customers?
= yes

 No
‘You can change a sales order to an invoice with one dick.

Need help setting up?
Find A Local

+ QuickBooks Expert %
Leave... |

(fees may apply) < Back HNext >

2 Click Next.

Using sales receipts

If your customers pay you in full at the time of purchase, use a sales receipt in
QuickBooks to track the sale.

You can use a sales receipt to:

m Track each sale

m  Calculate sales tax

m Print a sales receipt

m Create a summary of sales income and sales tax owed

m Summarize daily or weekly sales on a sales receipt

Margaret Lockhart’s interior design business is not actually a retail store, so she does not
typically use sales receipts. She generally includes such sales on an invoice that she
sends to her customers that might include, for example, both design services and
products.
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To set up sales receipts:

1 On the “Using sales receipts in QuickBooks window, click No

EasyStep Interview

 Getanswers
QuickBooks Using sales receipts in QuickBooks
EasyStep Interview

Use a sales receipt when your customers pay in full at the time of sale. This is espedally
common in retail businesses.
.

N Some examples:
Interview Progress
A bookstore provides a sales receipt when the customer buys a book.

A TV repair shop provides a sales receipt when a customer picks up and pays for a repaired TV.

Do you want to use sales receipts in QuickBooks?

© Yes
& o
Need help setting up?
Find A Local
< QuickBooks Expert
(fees may apply) Leave... |

<Back | Next > |

Even though QuickBooks recommends that a retail-type business use sales receipts,

Margaret Lockhart does not operate a full retail establishment.
2 Click Next.
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Setting up QuickBooks

Choosing remaining preferences

The next series of windows ask “yes or no” questions that enable or disable different
QuickBooks features, based on your company needs. Simply click Yes or No, then click
Next to move forward in the Interview. For Lockhart Design, complete the preferences
by giving the following responses:

For this item... Select...

Billing statements No

Progress invoicing Yes

Bill tracking Yes

Do you print checks? | print checks

Inventory No

Credit and debit cards | accept credit cards and debit cards
Track time Yes

Employees No

Track multiple currencies No

Answering the series of questions about your business helps customize QuickBooks to
meet your specific business needs. Next, you'll set up your accounts.

Note: You can always change preference settings later, after the EasyStep
Interview. From the Edit menu, choose Preferences, and then select the
preference type in the left panel.

Setting up your business accounting

Next, QuickBooks helps you set up the basic accounting you'll use to track your
business, referred to as your chart of accounts. To set up the chart of accounts, you need
to:

m Determine the start date of your business

m Enter account balances

m  Decide how you want to categorize your income and expenses

The chart of accounts is the framework used to categorize the information and

transactions used to create reports. By using a chart of accounts and creating reports,
you’ll always know the current state of your business.

The chart of accounts is made up of five types of accounts common to all businesses and
you categorize transactions into one of these five account types.
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Choosing a start date

Before you start entering your company’s financial data, you need to choose a
QuickBooks start date. This is the starting point you want to use for all your QuickBooks
accounts. The start date is the date for which you give QuickBooks a financial snapshot
of your company assets and liabilities.

Once you decide on a start date, you enter all your company’s transactions since that
date. That’s why you should choose a start date that’s not too far back in the past for you
to handle. Many business owners like to use the last day of a financial period as their
start date, such as the end of last fiscal year, last quarter, or last month. You need to enter
all historical transactions from the day after your start date up through today. For
example, if you decide on a start date of March 31, you’d enter your historical
transactions from April 1 up through today.

When choosing the start date you want to use for your own QuickBooks company file,
consider this question: Is having a lot of historical data important to you? If it is, you’ll
want to choose a start date as close to the beginning of your fiscal year as possible.

If historical data is not very important to you, you can make setup easier by choosing a
start date as close to today as possible. (You only have to enter historical data between
your start date and today.)
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To choose a start date:
1 On the “Using accounts in QuickBooks” window, click Next.
The “Select a date to start tracking your finances” window appears.

2 Select “Use today’s date or the first day of the quarter or month,” and then enter

12/31/2008.
5I
iy Getanswers
QuickBooks Select a date to start tracking your finances

EasyStep Interview
—
| " Beginning of this fiscal year: 01/01/2008

Interview Progress In order to complete this year's tax returns, you'l need to enter transactions
from the beginning of this fiscal year to today.

The date you select will be your start date in QuickBooks.

%' Use today's date or the first day of the quarter or month.
You'l need to enter transactions from this date forward.

| 12/31/2008 B
What date should T choose?
Need help setting up?
Find A Local
7 QuickBooks Expert @
(fees may apply) Leave... < Back HNext >

3 Click Next.
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Setting up QuickBooks

Entering bank accounts and opening balances

The bank accounts section of the EasyStep Interview is where you enter any bank
accounts you want to track and enter opening balances.

The balance sheet accounts in the QuickBooks chart of accounts start with an opening
balance of zero. Before you begin working in QuickBooks, you need to enter an opening
balance for each balance sheet account as of your start date.

The opening balance is important because QuickBooks can’t give you an accurate
balance sheet (what your company owns and what it owes) without it. An accurate
balance sheet gives you a true picture of your company’s finances. Also, if you start with
an accurate balance as of a specific date, you can reconcile your QuickBooks bank
accounts with your bank statements, and your QuickBooks checking accounts will
show the actual amount of money you have in the bank.

The easiest way to determine an account’s opening balance is to work from an accurate
balance sheet. If you have a balance sheet as of your start date, you can take the opening
balance from there. During the EasyStep Interview, you can enter opening balances for
bank accounts only. You’ll learn later how to enter opening balances for other types of
accounts after you've completed the EasyStep Interview.

Let’s assume Margaret Lockhart wants to enter an opening balance for her checking
account. The opening balance for a QuickBooks bank account is the dollar amount in
the bank on the start date. This amount can be determined two ways: using the ending
balance on the last bank statement on or immediately prior to the start date, or using
the bank account balance from a balance sheet prepared by an accountant. Margaret has
arecent bank statement for this account, so we’ll use that method.

To enter the checking account opening balance:
1 On the “Add your bank account” window, click Yes.

5I
iy Getanswers
QuickBooks Add your bank account

EHb}'StB[J Interview ‘fou should add ane bank account to the QuickBooks chart of accounts for each checking,
—_— savings, or meney market account your company has, We recommend you add at least one

T bank account now. You can always add more accounts in QuickBooks later.

Interview Progress
‘Would you like to add an existing bank account?
= évesé

" Mo, Tll add a bank account later,

How can T add my bank accounts later?

Need help setting up?

Find A Local
7 QuickBooks Expert @

(fees may apply) Leave... < Back HNext >
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2 Click Next.

w

Type Checking as the name of the account.
4 For “When did you open this bank account?,” click Before.

Your screen should look like this:

EasyStep Interview ﬂ

iy Getanswers

QuickBooks Enter your bank account information
EasyStep Interview
—

e Bankaccountname [

Interview Progress Y

This information will help you identify your bank account while using QuickBooks.

Bank account number l—
Bank routing number l— How do I find this?

* When did you open this bank account?
= fBefore 12/31/2008

 Onorafter 12/31/2008

Need help setting up?
Find A Local

7 QuickBooks Expert @
Leave...

(fees may apply)

5 Click Next.

6 In the “Enter your bank statement information,” enter 12/28/2008 as the Statement
ending date.
7 Inthe Statement Ending Balance field, type 8359.00.

As you enter transactions between the start date and today, you’ll record any
outstanding checks or deposits, which will allow you to reconcile your bank
account against the next statement.
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Setting up QuickBooks

Your screen should look like this:

x
 Getanswers
QuickBooks Enter your bank statement information

E‘db‘}‘StBIJ Interview Find the last bank statement you received with an ending date prior to
—_—m— 12/31/2008 (your start date).

Interview Progi Enter the ending date of this bank statement:

* Statement ending date I 12282008 H

Enter the ending balance on this bank statement:

Statement ending balance 8359.00

Where do I find this rate?

Need help setting up?

Find A Local
+ OuickBooks Expert @

(fees may apply) Leave... < Back Hext >

8 Click Next.

9 When QuickBooks asks if you want to add another bank account, click No. Then
click Next.

Reviewing the chart of accounts

Asyou learned in Lesson 1 of this guide, the chart of accounts lists balance sheet
accounts, income accounts, and expense accounts. When you create a new QuickBooks
company, you select a company type that most closely matches your type of business,
and QuickBooks sets up a chart of accounts for you.

The chart of accounts is made up of five types of accounts common to all businesses—
the income and expense accounts used by the Profit and Loss Statement, and the asset,
liability, and equity accounts used by the Balance Sheet. Each time you enter a
transaction, QuickBooks will prompt you to categorize it into one of these five types of
accounts.

Because you chose an industry from the list earlier in the Interview, QuickBooks has
already created income and expense accounts for your company. Next, you’ll view the
preset income and expense accounts.




To review the chart of accounts:

1 Inthe “Review income and expense accounts” window, scroll through the preset
accounts to get an idea of what is included.

Note that from the list of accounts in this window you can remove or add accounts.
If you see accounts you do not need, you can clear the checkmark for the account
and QuickBooks removes it from the chart of accounts. To add an account, click in
the checkmark column.

x|
i Getanswers
QHI'CkBOGkS Review income and expense accounts
EasyStep Interview Income and expense accounts categorize money your business earns from, or spends on, normal
—_——— business operations.
I 5 for your industry are typically all you need
Interview Progress for income tax purposes. Explain
% Account Name Type |
ise Sales lincome 4
+ |5ales Discou Income _I
Service Sales Income
< |Merchant Account Fees Cost of Goods Sold
Product Samples Expense Cost of Goods Sold
Purchase Discounts Cost of Goods Sold
Purchases - Resale Items Cost of Goods Sold
v |Advertising and Promotion Expense
+ |Automobile Expense Expense
+ |Bank Service Charges Expense
Business Licenses and Permits Expense
Cash Drawer Payouts Expense
Cash Over and Short Expense
Charitable Contributions Expense
i Computer and Internet Expenses Expense =

Hestore Recommendations

Why should I use the recommended accounts?

Need help setting up?

Find A Local
+ QuickBooks Expert @

(fees may apply) Leave... | < Back Next >

‘You can modify your chart of accounts anytime after completing this interview.

Click Next to go to the next window.
Click Finish to complete the EasyStep Interview.
If the QuickBooks Learning Center appears, click Go to QuickBooks.

G A WN

If the QuickBooks Coach appears, click Start Working.

After you have completed the EasyStep Interview, use the information in the help
options described later in this chapter to help you make changes and adjustments to
your company file.
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Completing company file setup

After you have created your company file using the EasyStep Interview, you can begin
using QuickBooks to run your business. However, there are some additional tasks you
might need do to make sure the company file is properly set up and that the data is
complete.

QuickBooks is based on four key concepts: Customers, Vendors, Accounts, and Items. If
you take two minutes now to understand these basic concepts, you'll be able to get
started quickly and correctly with your company information.

m  Customer: A customer is anyone who pays you. This can mean patients, donors,
members, legal or consulting clients, or your typical retail customer.

m  Vendor: A vendor is anyone you pay, except for employees. This can mean
subcontractors, utility companies, your landlord, tax agencies, or suppliers.

m  Account: There are two types of accounts—real world accounts, such as checking
accounts, and income and expense accounts that you use to group transactions for
reporting purposes. For example you may want to create expense accounts to track
office supply purchases separately from advertising costs. All accounts are listed on
your chart of accounts. If you choose a tax form, you can associate accounts with tax
lines, which would make preparing for tax time easier.

m Item: An item is anything you want to put on an invoice. This includes parts,
services, labor, discounts, and taxes.

This section covers how to set up customers, vendors, and items, and how to add an
income account.

Adding customers

In order to bill customers with QuickBooks, you need to add your customers.

By entering details about the people and companies you do business with, you can
personalize their bills, send invoices easily, and quickly view the status of their
accounts. You can add new customers at any time.

Note: You can also add customers and vendors as you perform everyday tasks. For
example, if you enter the name of a new customer when filling out an invoice,
QuickBooks will prompt you to enter information about this customer. You can
choose from two quick setup options: Quick Add and Set Up. Quick Add adds
the name to the list and you add details later. Set Up lets you enter the details
right away.
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To add a customer:
1 Click Customer Center in the icon bar.
2 Click the New Customer & Job menu button, and then choose New Customer.

3 In the Customer Name field, enter the name of the customer as you'd like it to
appear on your Customers & Jobs list. For this exercise, type Smith, Lee, and then
press Tab.

You want the list to show last names first.
4 Press Tab in the Opening Balance field to leave this field blank.

The Opening Balance field tells you how much each customer owes you on your
start date so that when you enter the rest of your transactions from your start date
to today, all balances since your start date will be accurate.

For now, leave this field blank. Lockhart Design is planning to set up one or more
jobs for this customer. QuickBooks will calculate and track the overall balance for
this customer from the balances you enter for the individual jobs.

In Address Info tab, click in the First Name field and type Lee.

Press tab and type M. as the middle initial and in the Last Name field, type Smith.
Press Tab to go to the Address field, and then press Enter after Lee M. Smith.
Type 43 Hampshire Blvd and press Enter.

© 0 N O O

Type East Bayshore, CA 94327.

10 Click the Copy button to copy the address to the Ship To field. Click OK in the Add
to Ship To Address Information window.

You can have and use more than one Ship To address per customer or job, but Lee
Smith uses only one address.
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Your screen should resemble the following graphic.

- |O| <

Customer Name |5miﬁ-|, Lee

How do I determine K

EESRE T I ezl I'3'-3-".'3‘5‘-"'200:'r B| g opening balance?

Cancel

Address Info I Additional Info I Payment Info I Job Info I

Mext

s

Company Name | Contact ILee M, Smith

Help |
P e I Frirs I O Customer is
First Mame ILee M.I [ | FAX | inactive
Last Name ISmiiﬁ Alt. Phone I
Alt. Contact |
E-mail |
Cc |
Addresses
Bill To Ship To [Ship To 1 hd
Les M, Smith Lee M, Smith

43 Hampshire Blvd 43 Hampshire Blvd

East Bayshaore, CA 94327 L | |East Bayshare, CA 94327 7
Go to Client
Manager
Edit |

AddNewl Edit | Delete |

[V Default shipping address

11 Click OK to add this customer.
The Customer Center appears, with the Customers & Jobs list along the left side.

Note: The Customers & Jobs list is the same list as the Customer:Job list. It is
called Customers & Jobs on the Customer Center, and it is called
Customer:Job on forms. It is sometimes also referred to as simply the
Customer list.

Adding a job

You do not need to add jobs to the Customers & Jobs list if your company never does
more than one job or project per customer. Jobs in QuickBooks are optional. If you often
perform multiple jobs for the same customer, you can use jobs in QuickBooks to track
the activity for each job separately. That way, you can create reports that show the
income and expenses for each job.

Lockhart Design wants to track jobs for Lee Smith.

To add a job for a customer:
1 Inthe Customers & Jobs list, right-click Smith, Lee and choose Add Job.

The New Job window looks similar to the Customer window. QuickBooks has
already filled in several fields for you for Lee Smith.

2 IntheJob Name field, type Patio, and press Tab.
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3 In the Opening Balance field, type 862 and press Tab.

You want to keep track of the balances for each job. QuickBooks calculates and
tracks the overall balance for this customer from the balances you enter for the
individual jobs.You want to keep track of the balances for each job.

Note: The information QuickBooks fills in comes from your customer's
record. If you make any changes here, the changes affect only this job. For
example, if your customer's billing address is different for this job, you can
enter the job address without affecting the customer's main address.

4 Enter 12/31/2008 in the As Of field to indicate that this was the balance outstanding
for this job as of the QuickBooks start date.
5 Click the Job Info tab and choose “In Progress” from the Job Status drop-down list.

Job status information is for your records—it gives you a way to keep track of each
job. When you create a customer list report, QuickBooks includes the status of each
job on the report. You can also see the status of a job by clicking a job in the
Customers & Jobs list and looking in the Job Information area.

6 For the Start Date, type 12/15/08 and press Tab.
7 Inthe Projected End date, type 3/15/09 and press Tab.

The dates help you track how long each job takes and how well you are able to
estimate the length of a job. When you create a customer:job list report, you can add
columns that show the start date, your projected end date, and the actual end date
for each job.

Your screen should resemble the following graphic:

Job Mame |pa1j.;.

Opening Balance |862.DD as°f|12fslf2003@ How do I determine

the opening balance? OK |
[ Address Info ] Additional Info l Payment Info I Job Info I
Cancel |

Job Status Start Date Projected End  End Date Mext |
|1n progress | |12/15/2008 E| |o3/15/2009 ] || = Help |
Job Description Job Type

I I ﬂ [T lobis inactive

8 Click OK.

55



Setting up QuickBooks

9 Ifyou see a message about a past or future transaction, click Yes to save the
transaction.

The job now appears under Smith, Lee in the Customers & Jobs list.

Customers & Jobs I Transactions
View IAcﬁ\re Customers =] I |

Find | 3'

Mame | Balance Total
+Smith, Lee 862.00

10 Close the Customer Center.

Adding vendors

In order to pay your bills with QuickBooks, you need to add your vendors. Nearly
everyone you pay, other than employees, is a vendor.

You can add new vendors at any time. QuickBooks uses the Vendors list to hold
information about the people and companies you do business with; for example, this
list could include the phone company, your office supplies vendor, and your tax board.

To add a vendor:
1 Click Vendor Center in the icon bar.
2 Click New Vendor in the button bar.

3 Inthe Vendor Name field, enter the name of the vendor as you'd like it to appear on
your Vendor list. For this exercise, type Fay, Maureen Lynn, CPA, and then press Tab.

E

In the Opening Balance field, type 350, which is the amount you owed this vendor
as of the start date. Press Tab.

In the As Of field, enter 12/31/06.

In the Address Info tab, click in the First Name field and type Maureen.

Press tab and type L. as the middle initial and in the Last Name field, type Fay.
Press Tab to go to the Address field, and then press Enter after Maureen L. Fay.

© 0 N O O

Type 200 Royal Rd. and press Enter.
10 Type Bayshore, CA 94326.
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11 Clickin the “Print on Checks As” field, and type Maureen Fay.

Your screen should resemble the following graphic.

Vendor Name IFay. Maureen Lynn, CPA
) — How do I determine
Opening Balance  [350,00 25 0f [12/31/2006 B the opening balance?

Cancel

Address Info I Additional Info ] Account Prefill I
Mext

Company Namel Contact IMaureen L. Fay Help
Mr. M. /... I Fhone I r vender is
First Name |Maureen M.L |L, FAX | inactive
Last Name |Fay Alt. Phone I
MName and Maureen L. Fay Alt, Contact I
Address 200 Royal Rd. Bl [
Bayshore, CA 94326
Cc I

Print on Check as

Address Details | |Maureen Fay|

i §

12 Click OK to add this vendor.

13 If you see a message about a past or future transaction, click Yes to save the
transaction.

The new vendor appears on the Vendor list.

Vendors I Transactions ]
View [Active Vendors =] -+ |

Find | il

MName Balance Total

Fay, Maureen Lynn, CPA

14 Close the Vendor Center.
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About customer and vendor types

Customer and vendor types let you categorize your customers and vendors in ways that
are meaningful to your business. For example, you could set up your customer types so
that they indicate which industry a customer represents, a customer's geographic
location, or how a customer first heard about your business. You could set up your
vendor types so that they indicate a vendor's industry or geographic location. For
example, you might create the type Painters with the subtypes Exterior and Interior.

m Commercial photographers might use customer types to record a customer's
primary interest: graduation, portraiture, weddings, and so on.

m Building contractors might use vendor types to classify their subcontractors by
geographical location so they can use the ones closest to each job.

You can create reports and do special mailings that are based on your customer and
vendor types. For example, if you use customer types to categorize your customers by
location, you could print mailing labels for all the customers in a particular region.

Setting up additional accounts

During the EasyStep Interview, you added one checking account for Lockhart Design.
There are two basic types of accounts: balance sheet accounts, such as savings or
checking, and accounts used to group transactions for reporting purposes, such as
income and expense accounts. Income and expense accounts track the sources of your
income and the purpose of each expense. When you record transactions, you usually
assign the amount of the transaction to one or more income or expense accounts.

In the EasyStep Interview, you selected “Retail Shop or Online Commerce” as the
industry for Lockhart Design. QuickBooks created a chart of accounts based on the
retail industry. However, Margaret Lockhart also receives income from design
consulting. She needs to modify the chart of accounts to add an income account for
consulting.

Adding a new account

You may need to add one or more of the following accounts:
m Income accounts to track new sources of income
m  Expense accounts to track new types of expenses

m Bankaccounts when you open new checking, savings, or money market accounts at
your bank

m  Credit card accounts when you acquire new credit cards
m  Other kinds of balance sheet accounts to track specific assets, liabilities, or equity

For example, you may need to add a fixed asset account to track the depreciation of
anew equipment purchase, along term liability account to track a business loan, or
an equity account to track the investment from a new business partner.
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A complete list of your business’ accounts and their balances appear in the chart of
accounts. You use a chart of accounts to track how much money your company has,
how much money it owes, how much money is coming in, and how much is going out.

For Lockhart Design, you’ll add an income account for her consulting income.

To add an income account:

1 From the Lists menu, choose Chart of Accounts.

Click the Account menu button and choose New.

In the Add New Account window, choose Income, and then click Continue.

Click in the Account Name field, and type Consulting.

a h~ WN

From the Tax-Line Mapping drop-down list, choose “Sch C: Other business
income.”

Your screen should resemble the following graphic.

REE
'ﬂ'- Account Type  [Income ~]

Account Mame |Consulting Select from Exarples

[ Subaccount of | ﬂ

— Optional

Description

Mote |

Tag-Line Mapping [ET i How do T chonse Ehe right ta line?

Save & Close | Save & Mew Cancel

6 Click Save & Close, and then close the chart of accounts.

59



Setting up QuickBooks

Adding

items

In QuickBooks, an item is anything that your company buys, sells, or resells in the
course of business, such as products, shipping and handling charges, discounts, and
sales tax (if applicable). You can think of an item as something that shows up as a line
on an invoice or other sales or purchase form.

Items help you fill out the line item area of a sales or purchase form quickly. When you
choose an item from your Item list, QuickBooks fills in a description of the line item and
calculates its amount for you.

While they provide a quick means of data entry, a much more important role for items
is to handle the behind-the-scenes accounting. When you create an item, you link it to
an account; when the item is used on a form, it posts an entry to that account and
another entry to the appropriate accounts receivable, accounts payable, checking, fixed
asset, or other account.

When creating items, consider how much detail you want on your invoices or
statements and set up items with that level of detail in mind. For example, if you are a
seamstress who creates and sells home accessories, you can set up a single item and
charge a flat rate for a certain size of couch pillow, or you can break that pillow down
further into labor and materials.

QuickBooks provides several different types of items. Some—such as the service item or
the inventory part item—help you record the services and products your business sells.
Others—such as the subtotal item or discount item—are used to perform calculations
on the amounts in a sale.

For Lockhart Design, you'll set up a service item for billing the time used for initial
consultation for a design project. You’ll assign it to the new Consulting income
account.

To add an item:
1 TFrom the Lists menu, choose Item List.
QuickBooks displays the Item List.

[tem Lis _ O] %
Look for | in |AII fields ﬂ Search | Heset | [ search within results
Mame Description Type Account On Sal... | Price
<+ Consignment. .. |I:Z|:||'|::il:u'|en:| Mon-Inventory Part [tem Description |l'-h:nru-irr-.-'E|'|. ..
@ Mon-nventor... |Non-inventory part item description Mon-nven... |Merchandis... 0.00
+Local Tax Local Sales Tax Sales Tax ... |Sales Tax P... 0.0%
+0utofState  |Out-of-state sale, exempt from sales tax Sales Tax ... |Sales Tax P... 0.0%
+5tate Tax State Sales Tax Sales Tax ... |Sales Tax P... 0.0%

Activities -| Reports .| Excel 'lrIncludeina_ctive

2 Click the Item menu button, and choose New.

3 In the New Item window, choose Service from the Type drop-down list.
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4 Clickin the Item Name/Number field and type Initial Design Consultation.

5 In the Description field, type Initial design consulting.
The description will appear on sales forms when you use the item.
6 Clickin the Rate field, and type 40.
7 Inthe Tax Code field, choose “Non-Taxable Sales” from the drop-down list.
8 In the Account field, choose Add New.
9 In the Add New Account screen, enter Consulting in the Account Name field, then

click Save and Close.

Your screen should resemble the following graphic.

MI

Type 0K
Servi | Use for services you charge for or purchase, like
I ervice A . ;

specialized labor, consulting hours, or professional Cancel

fees.

Mext
Item Name MNumber [ Subitem of

Custom Fields
IInih’aI Design Con... | =

fhkt

Spelling

r Unit of Measure

Enable... |

[ This service is used in assemblies or is performed by a subcontractor or partner

Description Rate I 40.00
Initial design consulting Tax Code INon -

Account  |Consulting i

How can I set rates by customers or employees?

|- Item is inactive

10 Click OK to add the new item to the Item List.

The item now appears in the Item List.

fem Lis _ | O] %

Lool;forl in IAII fields ﬂ Search | Reset | ™ Search within results

Mame Description Type Account On Sal... | Price

+ Initizl Design.., |Initial design consulting 5 | Consulting

+Consignment. .. |Consigned Non-Inventory Part Item Description . |Merchandis. .. 0.00
«Mon-nventor... |Non-nventory part item description . |Merchandis. .. 0.00
+Local Tax Local Sales Tax . |5ales Tax P... 0.0%
+QutofState  |Out-of-state sale, exempt from sales tax . |5ales Tax P... 0.0%
+5tate Tax State Sales Tax . |Sales Tax P... 0.0%

Activities -| Reports * | Excel 'lrIncludeina_ctive

11 Close the Item List.
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Entering historical transactions

If your QuickBooks start date is before today’s date, you also need to enter past
transactions so that you have complete financial records from the start date forward. It
is important to enter historical transactions in this order:

1 Allsales (sales receipts, invoices, or statement charges)

Customer payments received for outstanding invoices after the start date
Bills received since the start date

Bills paid since the start date

Deposits made to any of the accounts since the start date

o a0 b~ WD

Any other checks written (other than bills) since the start date

Learning more about the company setup process

When you are setting up your own company in QuickBooks, you may want to view the
tutorials available in the Learning Center to help you finish setting up your own
company file. The information provided in the videos gives you an overview of the
program and more detailed information about using specific parts of the product.

To open the Learning Center:

m From the Help menu, choose Learning Center Tutorials.

For more information, choose Support from the Help menu.

Getting help while using QuickBooks

QuickBooks provides extensive help in various formats. When you have questions,
QuickBooks provides:

m  Onscreen Help to provide conceptual information and step-by-step instructions.

m Tutorials on key tasks. These are available by choosing Learning Center Tutorials
from the Help menu.

m Live Community. Instant access to frequently asked questions and experts who can
answer your own questions.
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Using onscreen Help

The onscreen Help provides several different types of information:

m Conceptual explanations of how to apply QuickBooks to your particular business
situation.

m Step-by-step instructions.

m  Asearch engine that provides you with a list of topics related to the word or phrase
you enter.

m Information relevant to the task you are currently performing.

To view onscreen help:

When you launch QuickBooks help, it displays information about the task you are
currently performing along with alist of topics relevant to what you are doing. There are
several ways to access QuickBooks help:

m Press the F1 key on your keyboard.
m  Click the Help icon in the icon bar at the top of the screen.

m From the Help menu, choose QuickBooks Help.

Finding a topic in the onscreen Help

Suppose you want to find out how to change the information about a customer. You can
type what you're looking for in the Help Search field, and QuickBooks displays a list of
topics.

To find a topic in onscreen Help:
1 From the Help menu, choose QuickBooks Help.

The Relevant Topics tab displays a list of topics related to the QuickBooks screen you
are using.

2 Click the Search tab.
3 Type customers and click the arrow button.

QuickBooks Help displays a list of topics related to customers.
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4 Click “Edit or change customer information.”

QuickBooks displays the topic in the lower portion of the help window.

i

Live Community Help
Relevant Topics Search
[customers +

15 topics found:

? Edit or change customer
information

2?1 Modify {change) a
memorized report

2 [Nonprofit] Tracking
donors or members by
type

2 [Monprofit] Preparing
reports for donors -

4| |»

c Back a | '.EJ Print Topic

Edit or change customer
information

:[To do this task -

1. Click Customer
Center.

2. Onthe Customers &
Jobs tab, double-click
the customer you want
to edit.

3. Inthe Edit Customer
window, verify that the
name of the customer
appears in the
Customer Name field
as you'd like it to
appear in your
Customers & Jobs list.

' If you want the list

" to be alphabetized
by last names and
the customer is
Joan Green, enter
Green, Joan.

4. You can adjust the
current balance if you
made a mistake when :I
e oais o a Ad|

5 Close the Help window.

Closing the company file

As you enter information in your company file, QuickBooks saves what you enter.
When you are finished working on a file, you can close the file.

To close the company file you just created:
m From the File menu, choose Close Company.
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